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|1 APPLICATION

KNXeasy is connected to your local area network via ethernet. It translates the binary KNXnet [ IP
bidirectional into a simple ASCII protocol. Internally, the device uses an address-state table as a snapshot
KNX installation. For later analysis, the the KNX telegrams can be stored into a MySQL database. For
configuration only the free of charge b.a.b-technology manager software is needed.

‘ Client ‘ | Client ‘
LAN
10/100MRBit
KNXeasy- KNXnet/TP EIB
Protokoll

"

Figure 1 KNXeasy connecteda

Specifications

Montage top hat rail

Connectors DC-IN (10-30 V), RJ-45(10 Mbit Ethernet)
Nominal current 70mA

Max. current 180mA (Bootvorgang)
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I 2 THE KNXEASY PROTOCOLL

The KNXeasy protocol is a very simple ISO-8859-1 encoded ASCII protocol.
Command Structure

Each parameter is divided by space characters and may not contain whitespaces itself.
ABDEF

A: Source- | Targetdescriptor

B: SystemID

C: Command

D: Groupaddress

E: EIS-Type

F: Data

Source- [ Targetdescriptor

Defines the source or target protocol. When a telegram is received in the KNXeasy protocol, this
descriptor defines into which protocol the telegram will be translated. On the other way it defines the
original protocol in which this telegram has been receivedl|.

Values:
* KNXnet/IP
SystemID

SystemlID of the KNXnet/IP installation. In KNXnet/IP there can be O to 255 different system identifiers.
for other applications values of O to 65535 are possible.

Command
The action which will be or has been executed.
Values:
« write KNXeasy -> KNXnet/IP: The given value (data) will be sent on the bus.

e KNXnet/IP -> KNXeasy: The value has been sent on the bus..

e read Request the current value of a group address. The answer will be generated using the
internal address status table.

e - status The answer to a read request which will only be sent to the requesting client.

e Groupaddresses

e The groupaddresses (destination address) can be used in two or three layer format.

e Three layer:

e main group/middle group/sub group

e Two layer:

e main group/sub group

e Comment:

e The groupaddresses are packed in an array of two bytes. The format just specifies the
presentation of these two bytes. In both formats, the most significant bit differs the physical
addressing from the group addressing.

e For three layer format, the following 4 bit are used for the main group (b, range O - 15). 3 bit
are reserved for the middle group (c, range O - 7) and the lowest 8 bit defines the sub group (d,
0 - 255).

e abbb bccc dddd dddd

e The two layer format just combine the middle and sub group as the 2 layer sub group with 11
bit length (c, range 0-2047). The main group still remains as 4 bit (b, range 0-15).

e abbb bccc ccce ccec

e Timestamp
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e The answer to a status read command contains a timestamp to compare the telegrams to each

other:

e yyyy/mm/dd HH:MM:SS

e y=year; m=month; d=day; H=hour; M = minute; S = second

EIS-Typ und Daten

EIS 1 on|off | 1]0

EIS_2 on | off | 1| 0] brightenX | dimX (X = dimming level)

EIS_3 day:

Mon | Tue | Wed | Thu | Fri | Sat | Sun
or

Mo | Di | Mi | Do | Fr | Sa | So

time:

hour:minute:second

EIS_4 day.month.year

EIS_5 x.y (z.B. 15.3; 2 Byte floating point))

EIS_6 X%

EIS_ 7 up | down

EIS_8 on | off | disabled | enabled

EIS_9 x.y (z.B. 15.3; 4 Byte floating point)

EIS_10u x=0. 65535

EIS 10s X=-32768..32767

EIS 11u x=0..4294967295

EIS_11s X=-2147483648 .. 2147483647

EIS_T2 Not supported!!

EIS_ 13 a-zA-Z

EIS_14u x=0.. 255

EIS 14s X=-128..127

EIS_15 “abcdefghijkimn® (max 14 Zeichen)

EIS_UNDEF . When a telegram is received from KNXnet/IP, KNXeasy tries
to look up the groupaddress in the ESF+ data. If the
groupaddress is not configured in the ESF+ file, KNXeasy
sends the raw data of the telegram with EIS-type EIS_UNDEF
each byte prefixed with Ox.

KNXnet/IP O write 2/257 EIS_UNDEF 0x19 0x29
Examples:

KNXnet/IP O write 3/1/4 EIS_1 off

KNXnet/IP O write 3/2/4 EIS_15 ,Lunchtime*

/
KNXnet/IP O read 1/1
/

KNXnet/IP O status 1/1 2008 /04/09 10:18:00 EIS_5 12.80
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I 3 PREPARE ESF DATA

Dokumentation KNXeasy Gateway

Since KNXnet/IP telegrams do not contain any information about the data, KNXeasy needs a table in
which groupaddresses are linked to EIS-types. Using this table the KNXeasy knows how to convert the
data of the telegrams into human readable values. This information gets stored into a so-called ESF+ file.

ESF Import

N
Import AddressData From an ESF File

=10l x|

=]

Fram file: | C:iDokumnente und EinstellungeniMathias|Eigene Date
Impart as Syskem ID: I o :I
Merge with: INone j
% pddinew addresses
€ addand replace addresses
< Back | [k = | Finish | Cancel |

Figure 2 ESF Import

In the EIB programming software ETS you can export an ESF-file with the OPC export function. In this file
all configured groupaddresses are listed and you can import this file into the manager. Go to the file ->

import function and you will see the above window.

You have to select a system id for the selected ESF file for clear identification of the KNX installation
(default 0). With the merge-option you can integrate this file into an already opened ESF editor. If the
ETS project will be changed, you can add those changes to the ESF+ file using the merge function.

If you click finish, the editor will be opened with a tree structure of the project data.

Most important is the column EIS type. Here you have to assign the correct EIS types to the group
addresses. You can change the value by clicking into the EIS type field or by selecting one or more rows
and using the popup menu with a rightclick. When all grouaddresses are configured correctly export the

data into a ESF+ file.

IEManager - b.a.b-technologie gmbh 0] =]
Filz  Corfiguration ‘Window Extensions Help
J = J [% L& o&fF 7 | [ Project Explor...
If:E"‘Damotafel Unna rechts_1{2).esf 23 =8
Mame | Address | Anzahl | EI5 |
=l L Demotafel Unna rechts_1(2) System [D: 0 15
[l = SchalkenjDimmen rechts EIE Maingroup 10 5
[ 1= Neue Mittelaruppe Middlegroup: 0 5
=J= Schalten 6152 Leuchte 1 rechts 1001 EI5 1 (1 Bit OnfOff)
=Jx= Schalten 6152 Leuchte 2 rechts 10f0f2 EIS 1 (1 Bit ©nfOff)
<= Schalten 615! 104043 EIS 1 (1 Bit OnfCFf)
[oos | Junened ||

EIE Maingroup 11 2
Middlegroup: 0 z
11fof1
11fofz
EIB Maingroup 12
EIB Maingroup 13 4

[l = Jalousie rechts
[ 1= Neue Mittelaruppe
=J= auffab
<= stop
== Heizung rechts
= Leistung

3

EIS 1 (1 Bit OnjOff)
EIS 1 (1 Bit OnjOff)

Figure 3 Simple Adress Manager
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Additionally to the ESF+ file you should save the editor into a .sam file. This file is used for later changes
to the project data.
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I 4 CONFIGURATION

To configure the KNXeasy you need the Manager software. Open the connection dialog in the menu
Configuration -> KNXeasy.

The delivery status of KNXeasy is IP address 192.168.1.2 and SSH port 22.

If all neccessary changes were made, the configuration can be saved using the save button in the upper
right corner of the editor window.

4.1 NETWORK PARAMETER

To integrate KNXeasy into your network you might need to change the network parameters.

Network Parameters v [

Network Interface Advanced Network Settings

Configure the settings for the network interface. Configure advanced network parameters

DHCP r SsHPat |22 =]
1P-Address | 172.31.49.58

Metmask | 255.255.255.0

Gateway |172.51.49.7

DNS Server #1 | 172.31,49.1

NS Server #2 |

DNS Server #3 |

Metwork, Parameters] KM¥xeasy Configuration | Swsbem |
Figure 4 Network Parameter

Here you can configure the following parameters:
Network Interface

DHCP With the Dynamich Host Configuration Protocol (DHCP) the network parameters will
automatically be configured by a DHCP server. If you check this box all other fields will
be deactivated. You should not enable this function if there is no DHCP server in your

network.
IP address The IP address of the KNXeasy. (Default 192.168.1.2)
Netmask Subnet mask which identifies the Network in combination with the ip address. (Default

255.255.255.0)
Gateway The gateway which can be used for broadcast messages or a database connection. The
gateway must be reachable for the current IP address and subnet configuration.

DNS server You can define three DNS server. These will be used to resolv hostnames e.g. for the
database connection.

Additional Settings

SSH port This is the port of the internal SSH server for configuration and maintenance purposes.
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4.2 KNXEASY GATEWAY

Loglevel The loglevel is used for maintenance purposes and should not be changed. This
will decrease overall performance of KNXeasy.

Network interface The internal network interface to use for KNXnet/IP and KNXeasy protocol

Broadcast Adresse This address can be a broadcast or unicast address. KNXeasy messages will be
sent to this address via UDP. If you change the IP address or subnet mask of
your device, it might be neccessary to adapt the broadcast address, too. If you
are not sure which address to use, try out 255.255.255.255. Then KNXeasy will
sent messages to every available network

Broadcast Port This port will be used for sending and receiving KNXeasy messages. (Default
4950)
KNX installations KNXeasy can handle multiple KNX installations. Each installation is identified

with the SystemID in the KNXeasy protocol and the multicast address and port
for the KNXnet/IP protocol. Additionaly the KNXeasy has a physical source
address for each KNX installation.

KNXeasy Configuration v H
KNXeasy Gateway ESF+
Configure the settings for the KNxeasy Gateway, Upload the ESF+ Address Configuration File,
Loglewvel I 0 ﬁ I Brawse. ., Upload
Metwark Device I ethi File esisting: ves
Broadcast Address I 172,31.49.255 File size: 137,0KB

Broadcast Port I 4950 33

KM Installations

x|
KNeasy to MySQL Installation Marne
Configure the MySQL Database Settings.
Physical Address
activate tysaL
SestemID -
Hostname | IP | 172.31.49.49
Multicast Address I 224.0,23.12
My30L Part | 3306 =
Multicast Part I 3671 3:
Database | babtec
Username | babtec ’WI — |
Password | ssssse

Repeat Password | saenes

Table | kriceasy

Metwork Parameters | Kixeasy Configuration System‘
Figure 5 KNXeasy Configuration

ESF+

In this section you can upload delete or download the ESF+ file.

KNXeasy to MySQL

The KNXeasy offers the possibility to store all telegrams in a MySQL database for later analysis and

evaluation. This MySQL Server can be used in the local network as well as on the Internet (Gateway and
DNS must be correct).

In the database the plain text of the KNXeasy protocol is stored. In addition to this, the timestamp of the
KNXeasy as well as from the database server is saved for each dataset.

b.a.b-technologie gmbh | 11
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Activate MySQL
The IP address or hostname of the MySQL server. If you use an external server, the
gateway and DNS settings must be correct.

Hostname | IP
The IP address or hostname of the MySQL server. If you use an external server, the
gateway and DNS settings must be correct.

Database The name of the database to use for KNXeasy data.

Username The username for this database.

Password The password for this database

Table The name of the table which will be used to store KNXeasy data.

This is the create-statement for the KNXeasy table in a database called ‘babtec”
CREATE TABLE “babtec™ . knxeasy™ (

Tid” int(11l) NOT NULL auto_increment,
“source_protocol”™ varchar(20) NOT NULL,
“sernr” varchar(12) NOT NULL,
“timestamp™ varchar(50) NOT NULL,
“source” varchar(10) default NULL,
“dest” varchar(10) default NULL,
“eistype” varchar(10) default NULL,
“data” varchar(50) default NULL,
“sysid® varchar(10) default NULL,
“pid® varchar(10) NOT NULL,

“db_time~ timestamp NOT NULL default
CURRENT_TIMESTAMP,

PRIMARY KEY (Tid>)

) ENGINE=MyISAM

AUTO_INCREMENT=865

DEFAULT CHARSET=latinl;

The table can be created using the MySQL Client software or phpMyAdmin. This is the table structure:

int(11) NOT NULL auto_increment
id Primdrschliissel, eindeutige ID des Datensatzes
source_protocol varchar(20) NOT NULL
Quellprotokoll. KNXnet/IP | KNXeasy
sernr varchar(12) NOT NULL
Die Seriennummer des KNXeasy
timestamp varchar(50) NOT NULL
Interne KNXeasy Zeit
source varchar(10) default NULL
Physikalische Quelladresse
dest varchar(10) default NULL
Ziel-Gruppenadresse
eistype varchar(10) default NULL
EIS-Typ: EIS_UNDEF | EIS_1|EIS_2...
data varchar(50) default NULL
Die umgerechneten Klartextdaten
sysid varchar(10) default NULL

b.a.b-technologie gmbh | 12
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Verwendete SystemID
pid varchar(10) NOT NULL
Interne ProzessID des KNXeasy fir Wartungszwecke

timestamp NOT NULL default CURRENT_TIMESTAMP
Die Zeit des Datenbankrechners

4.3 SYSTEM

db_time

On the System tab you can change the internal time of KNXeasy. This time is used to correctly
timestamp the internal address table and the telegrams stored in the database.

System v B
System Information

Firmware Update
Information about the dewice and firmware.

Update the Firmware of your KNXeasy.

Times (dd mm.yvyyy HH:MM) 09.04.2008 15:30 Refresh |
Local Time | Commit Time: | Upload

Serial Humber [EToi70000311

Firmware Yersion [knpieasy 0.0.5

System Control
Control the Devics.

Restart Kiikeasy | Restart |

Reboot Devics \ Rieboat |

Network Parameters |KN#easy Configuration | System

Figure 6 System

The refresh button loads the current system time from the device. You can manually insert the correct

time or use the local time button to insert your client system time. The commit time button saves the
time to KNXeasy.

In the System Control section you can restart the internal KNXeasy software or do a complete system
reboot. If you use the reboot option, the device will not be available for about a minute.

If there are new firmware revisions you can update your KNXeasy using the Firmware Update section.

b.a.b-technologie gmbh | 13
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I 5 KNXEASY MONITOR

The KNXeasy monitor can be used to listen to KNXeasy messages on the network. You can also send
messages or do status requests.

[ knukeasy Manikar £ 1 =0

[= Configure Connection

Current Target: 255,255,255, 255

Target Host: [ 255.255 255,255 et Target
Part: [49s0 = | discornect...

KNxeasy Monitor

Received:  [17,24:40.640; Connecting. .. =
17:24:40.703: Connected UDP Socket on port 4950
L1715 KNEnet/IP O varite 1257 EI5_UNDEF Oxi1
875! KNXnet/IP O write 1257 E15_UNDEF 080
\656:; KNXnet/IP 0 write 1/1/2 EIS_1 off
\640; KIXnet|IP 0 write 112 E15_1 an
468 KNXnet/IP 0 write 1/259 EI5_UNDEF 0x31
L6565 KMXnet/IP 0 write 1/259 EI5_UNDEF 0:x20
046 KHXnet/IP 0 write 2/257 EI5_UNDEF 0x80 Dx19 029
1 265; KNXnet/IP 0 write 2/257 E15_UNDEF 0x80 0x19 0x29
290! KNXnet/IP O write 2/257 EI5_UNDEF 080 019 023
937 KNXnet/IP 0 write 3/1/4 EIS_1 off
J828; KIXnetyIP 0 writs 3174 E15_1 off
.593: KNXnet/IP O read 11
\593: KMxnet/IP O status 171 2008/04/00 10:18:00 EIS_5 12,80
‘! 937 KHXnet/IP 0 write 2/257 EI5_UNDEF 0x80 0x19 025
18:01: 26,687 KNXnet/IP O write 3/1/4 EI5_1 off
18:16: 26,578 KNXnetfIP O write 3/1/4 EIS_1 off

[ |
Command: send
[ Generate Command
Frotocal: | adaress: [ -+
SystemID: |0 = ers-type: [EI5 OHDER =l
Command: Iread j waluer |

KurT Command: | KNznetiIP O read 111

Figure 7 KNXeasy Monitor

To open the KNXeasy monitor click on the window menu and choose Show View > Monitor > KNXeasy
Monitor.

To send KNXeasy messages you have to configure a UDP broadcast or unicast address. With the
preconfigured address 255.255.255.255 you send KNXeasy messages into every network. If there is a
router between your client PC and the KNXeasy, it must be configured to route the UDP packages into
the target network.

The default port for KNXeasy is 4950. If you have a firewall, it must not block this port to see the
messages. To start recording click on the connect button.

In the main record window you will see all KNXeasy messages. Every message will be labeled with the
local PC time. This timestamp does not belong to the KNXeasy protocol. Using the command input you

can send KNXeasy messages on your own. These messages can be entered manually or generated using
the input mask.
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I 6 KNXEASY FUNCTION

KNXeasy bidirectionally translates KNXnet/IP data into the very simple KNXeasy ASCII protocol.

6.1 KNXNET/IP TO KNXEASY

When KNXeasy receives a telegram from KNXnet/IP it decodes the groupaddress and tries to fetch this
to the ESF+ data. If an EIS type has been assigned to that groupaddress, the KNXeasy transforms the
data into plain text values.

The generated KNXeasy message will be sent as a write command to the configured UDP broadcast or
unicast address. All clients which are listening on the KNXeasy port (default 4950) will receive this
message.

The message will also be saved into the internal address state table and to the optional configured
MySQL database.

6.2 KNXEASY TO KNXNET/IP

When KNXeasy receives a KNXeasy message, its data will be written to the address state table and the
optional MySQL database. The data object will be transformed using the EIS specification in the
message. KNXeasy generates a KNXnet/IP package and sends it to the configured Multicast address for
the given SystemID.

6.3 KNXEASY STATUS REQUESTS

A KNXeasy status request (read) will be answered with data from the address state table. There is no
option to request a status from the KNX installation defined for the KNXnet/IP protocol. When the
KNXeasy is installed into an installation, it will take some time until all addresses have been sent at least
once and are recorded into the address status table. The answer on the read command (status) will be
sent to the client via UDP unicast.

b.a.b-technologie gmbh | 15
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7 CONFIGURATION TOOL FOR THE KNXEASY
GATEWAY

Open the bab-tec manager with "manager.exe".

@'Manager - b.a.b-technologie gmbh - IEllil

File Configuration Window Extensions Help

= welcome &3 l

Welcome to b.a.b-technologie Manager

\,.) Learn about the Device Manager. ..

—:I)—' Learn about the Simple Address Manager (SAM])...

—
E=Info

Learn about the Home / Business Information Center (HIC / BIC)...
Center / ( / )

L 2
l Return to this page by choosing “welcome" from the "Help"-Menu,

|

figure 8 b.a.b.-technologie Manager

Click on "Configuration" and then on "KNXeasy".

x

Configure Connection

Set the parameters for the connection

IPjHost | 192.165.1.2

SSH-Part | 22 =

Proceed Cancel |

figure 9 Connetion Dialog

Type in the access data for your KNXeasy gateway and click "Proceed".

The manager connects to the gateway and the "Network Parameters" page opens.

b.a.b-technologie gmbh | 16
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7.1 CONFIGURATION PAGE NETWORK PARAMETER

@Manager - b.a.b-technologie gmbh -0l x|

File Configuration Window Extensions Help

Open Information Center =

i ’Qg Device Perspective  [T] Project Exploration

??‘*, KMzgasy 2 = O
Network Parameters v [
Network Interface Advanced Network Settings
Configure the settings For the netwark interface, Configure advanced network parameters
DHCP r 55H Part 2z =
IP-Address | 192.168.1.2
Metmask | 255.255.255.0
Gateway |
DNS Server #1 | 131.1858.5.4
DNS Server #2 | 134.100.33.240

DS Server #3 |

Metwork, Parameters | KNReasy Configuration . Syskem '

figure 10 Network Parameter
Here you can change the Network configuration of your gateway.

After changing the configuration for your requirements, click on
"KNXeasy Configuration" below.
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Dokumentation KNXeasy Gateway

7.2 KNXEASY CONFIGURATION

E‘Manager - b.a.b-technologie gmbh '

=10] x|
File Configuration Window Extensions Help
Cpen Information Center =
Ey ’Q Device Perspective [T Project Exploration
{E Kheasy 5 = 8
KNXeasy Configuration v [
KMXeasy Gateway ESF+
Configure the settings For the KNXeasy Gateway, Upload the ESF+ Address Configuration File,
Loglevel | 1 ::l | | Browse, ., | | Upload |
Metwark Device | File: excisting: yes
Broadcast Pork 4950 =
| A rese 2,660
KMxnet/IP Gateways

Add...
Siemens

Edit...

Ex

Metwork Parameters | Khreasy Configuration System'

figure 11: KNXeasy Configuration

The configuration of the gateway takes place on the left side in the array

"KNXeasy Gateway".
To add a new gateway, click "Add..."

(M .
I

0 :

|224.EI.23.12
|36?1 3:

Device Mame
Multicast 10
Multicast Address
Multicast Port

| Proceed I

Zancel |

figure 12 Eingabefenster

Enter name, multicast ID, multicast adress and multicast port of the new gateway.

Click "Edit..." to change the configuration of existing gateways.
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To delete a gateway from the list, click "Delete...".

@

In the array "ESF+" you can load esfp files into the gateway and download or delete existing files

7.2.1 SYSTEM

@'Manager - b.a.b-technologie gmbh
File Configuration Window Extensions Help

JOpen Information Center J =

=10l
%’ [ KM¥easy Monitor Perspective |’Q Device Perspective [E Project Exploration
{5 KKeasy B2 l = 08
System v [
System Information Firmware Update
Information about the device and Firmware Update the Firmware of yvour KNXeasy,
Serial Mumber BTO170000311 | Browse. ..
Firrmware Yersion kNXeasy 0.0, 3-prel
| Upload |

System Control

Control the Device.

Restart KMxeasy Restart |

Reboot Device Rebaaok |

Metwork Parameters |KMN¥easy Configuration | Svstem
figure 13 System
System information is displayed on this page.

You can restart the KNXeasy software or reboot the gateway (hardware). Furthermore you have the
possibility to do a firmware update.
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7.3 UPDATEFUNCTION

To install updates or plugins for the manager, click "Extensions" in the menu bar and then on "Install
and Update".

Search Results

]

X

i
oy o

Select Features ko inskall From the search result list,

'/‘-a..
N
"

Select the Features tao install:

Deselect All

More Info
Broperties
Seleck Required

Error Dekails, ..

HLLE

Update site for public manager updates

5 of 5 selected,

¥ show the latest version of a Feature only

[ Filter Features included in other Features on the lisk

= Back I Mext = I Einish Cancel

figure 14 Update

Now the manager looks for updates. Choose the updates or plugins you want to install in the following
window and proceed with "Next".

Now the chosen updates are shown detailed.
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=T

Feature License

Some of the features have license agreements that wou need to accept before proceeding with the ¥
installation, .\_-"")

| -
%hab-tec Manager: Care Ukils 0,0,z | [Enter License Description here, ] ﬂ
%Device Feakure 0.0.2
%bab-tec Manger: KurT Feature 0.0
%hab-tec Manager: Simple Address
%bab-tec Manager: Internal Tools

d | A [~

¢ T accept the kerms in the license agreements:

™ I do not accept the terms in the license agreements

= Back I Mext = I Eimish Zancel

figure 15 Install

Accept the license agreements and click "Next" to download the updates.
Following the download of the updates starts.

After finishing the download, you get asked if you want to install the updates.
Click "Install all".

After the installation of the updates, the manager has to be restarted.
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7.4 DATAMANAGEMENT

speichern

figure 16 datamanagement

The preparation of the EIB data takes place in the "simple adress manager”. With that data the
KNXeasy telegrams are generated.

For this purpose, you first have to create an esf file from the ETS.

(Datei=>Export=>0OPC-Export)

This file can be imported with the manager.
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7.4.1 IMPORT VON ESF DATEIEN

Click on "File" in the menu bar and then on "Import".

=

Select
Y

Import AddressData from an ESF file | g - 5 I

Select an import source:

-] ESF Impark

< Back I Mext = I Eimist Cancel

figure 17 Import

Mark "ESF Import" and proceed with "Next".
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ESF IMPORT

CE—— _ioix

ESF Import
P \

Impart AddressData from an ESF file g - 5
From File: | Browse, |

Irnport as Syskern ID: I 1]

IMerge with; INnne j
% add ew Addresses
) idd|and replace addresses

FCBad | weas [ B | caneel

figure 18 ESF Import esf

Choose the esf file, you created with the ETS before and enter the SystemID of the eibPort.
If you have imported an esf file before, you can merge the new with the old esf file.

At this, you have the options only to add new group addresses, or to replace existing group
addresses.

Click "Finish" to complete this procedure.

7.4.2 EDITING EIB GROUP ADRESSES

If you have imported an esf file, this file can be viewed and edited with the manager.

The editor area opens in every perspective, if an esf file was imported.

For proper performance of the gateway, the right EIS types have to be assigned to all group
addresses.
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RI=TEY
File Configuration Window Extensions Help
J Open Information Center J = J E‘—‘a] L
ﬁ | 5 KMzeasy Monitar Perspective
: o kafferl.sam 54 I =0
- Nan_'n_a | Address | Anzahl | EIS |
= L koffer 1 Syskemn ID: 0 2z
El == Zentral EIE Maingroup O 1
<= Zentral Aus 01 EIS 1 {1 Bit OnfCFF)
El 1= Beleuchtung EIE Maingroup 1 a
== Lampe 1 schalten 1m EIS 1 (1 Bit OnQfF)
== Lampe 1 dimmen 11 EIS 2 {Dimming)
<= Lampe 2 schalten 1z EIS 1 {1 Bit OnfCFF)
<= Lampe 2 dimmen 113 ;I
== Lampe 3 schalten 1/4 EIS 1 (1 Bit OnQfF)
== Lampe 4 schalten 1/5 EI5 1 {1 Bit on ) QFF)
“J= Lampe 1 Wert 16 EIS 6 {1 Byte %)
<= Lampe 2 Werk 17 EIS 6 {1 Byte %)
[l == Heizen EIE Maingroup 2 7
<= Heizen 210 EIS 1 {1 Bit OnfOFF
= Sallwert 21 EIS 52 Byte FP)
<= Isk-wart 242 EIS 5 (2 Byte FP)
== Komfort-Betrieb 213 EIS 1 {1 Bit OnfOFF)
<= Machtbetrieb 214 EIS 1 {1 Bit OnfOFF
= Fraostschutz i =] EIS 1 {1 Bit OnfCFF)
= akkueller Sollwert 26 EIS 562 Byte FP)
1= Jalousie EIE Maingroup 3 3
== Kontakke EIE Maingroup ¢ 3

|

figure 19 ESF

To define EIS types, click on the entry in the column "EIS" and change the value.

7.4.3 EIS TYPEN

EIS1

EIS 2

EIS 3

EIS 4

EIS5

EIS 6

EIS7

EIS 8

EIS9

EIS 10 unsigned
EIS 10 signed
EIS 11 unsigned
EIS 11 signed
EIS 12

EIS 13

EIS 14 unsigned
EIS 14 signed
EIS 15

On/Off (1 Bit)

Dim (4 Bit)

Time (3 Byte)

Date (3 Byte)
Floating-point (2 Byte)
Per cent value (1 Byte)
Motor (1 Bit)

Priority (2 Bit)
Floating-point (4 Byte)
Counter unsigned (2 Byte)
Counter signed (2 Byte)
Counter unsigned (4 Byte)
Counter signed (4 Byte)
Access code (4 Byte)
ASCII value (1 Byte)
Counter unsigned (1 Byte)
Counter signed (1 Byte)
Character string (14 Byte)
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7.4.4 SAVING DATA AS SAM FILE

Imported (and maybe edited) esf files get saved in the bab-tec manager as simple adress manager
(sam) files.

Click on "File" in the menubar and then on "Save as".

Speichern in: I@Eackups j "j I A '

| ") Backup Demotafel 18.09,2007
' | )Backups 0.7.3
Recent kofferz sam

Drateinamne: ﬂ Speichemn

D ateityp: Simple Addrezs M anager Filez Abbrechen |
E

figure 20 Save Data

Choose the path for the file and proceed with "Save".

7.4.5 EXPORT OF ESF+ FILES

To use the sam files in the KNXeasy gateway, the files have to be exported to esf+ files.
Click on "File" in the menubar and then on "Export".

Mark "ESF+ Export" and proceed with "Next".
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=10l

Select )
Choose export destination, | g E |

Seleck an export destination:

-y ESF+ Expart

< Back [dexk = | Einist I Cancel

figure 21 ESF Export

Choose the path for the esf+ file and click "Finish" to export the file.
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7.4.6 PERSPECTIVES AND VIEWS

The desktop of the bab-tec manager is based on perspectives. They are shown as tabs. Click on
"Window" in the menubar and then on "Open Perspective" to open a new perspective.

@Manager - b.a.b-technologie gmbh ;Iglﬂ

File Configuration ‘Window Extensions Help
| &
B | [ Project Exploraflﬁn

- HexCDnveﬂ?l—ﬂ'l_ View

~ASCIIHES

Perspective

ASCII | copy

HEX | copy

EIB-Address

cony |
cony |
3 Layer | ] ﬂl
cony |
oy |
cony |

2 Layer I _PI copy

1 Layer | Copy

HEX | copy

figure 22 ESF Export

You can open different "views" in every perspective. Those are the tools you can work with.
To open a new view, click "Views" in the menubar and then on "Show View".

The default views of the perspectives:
KNXeasy Monitor Perspective: KNXeasy Monitor
Editor area for group addresses
Device Perspective: Device Overview
Device Details
Editor area for group addresses
Project Exploration: Editor area for group addresses

You can open other views in every perspective.

To set the defaults, click the tab of the perspective with the right mouse button and choose "Reset".
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1.4.7 VIEWS - HEX CONVERTER

This tool is able to convert ASCII values into hex values and reverse.

Manager - b.a.b-technologie gmbh

figure 23 Views Hex Converter

Just type in the value, you want to convert into the matching array and the converted values appear in
the other arrays.
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7.4.8 VIEWS - DEVICE OVERVIEW

In the "Device Overview" all discovered eibPorts get displayed.

@Manager - b.a.b-technologie gmbh ;lglil

File Configuration ‘Window Extensions Help

J Cpen Information Cenker J =

E” |’ﬁ Device Perspective

|5 oo v 2| Holnle=EE

Marmne | Serial Mo, | Address | Skakus |
. Tg Favourites
E|'Eg Discovered

9 ep-test2 1000358311 ep-testZ.intrane. ..

e *Unnamed eibPort 100033911 eibport-defadlt.i. ..

|

figure 24 Views Device Overview

If you click on an eibPort with the right mouse button, you can add it to, or remove it from the
favourites.
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7.4.9 VIEWS - DEVICE DETAILS

In the "Device Details" you can watch the configuration of an eibPort. First you have to open the
"Device Overview" and mark an eibPort. Then open "Device Details".

@Manager - b.a.b-technologie gmbh ;Iglll

File Configuration Window Extensions Help

J Zipen Information Center J =

ﬁ |'2; Device Perspective

[ Device Details &3 } = O || O pevice overview 52 } g = | 5 | 0 Y =0
Paramster | alue |1 Mame | Serial Mo, | Address |
Flags 0

MAC-Address 00e04b 10 3c 42

Tvpe 2

P ep-testZ intranet. .. 1000358511 ep-test2.inkrane. .,
nekmask 255,255,255.0

Serial Mo, 100033811

System ID u]

Phevs, Addr 4.58.0

Device Mame ep-test2

Wersion 0.7.3-pres

Build Build 5858 (jsl@c...

Time 1193647759

S5H-Pork 22

HTTP-Paort &0

B TCP-Pork 1735 4 I I _,I
BMyIDP-Part 1735

flags 3 = H
Flash Lsed 123456759

Flash Free 987654321

Zonfig Svstem z

TTL Criginal 1

|

figure 25 Views Device Details

7.4.10  VIEWS - KNXEASY MONITOR

The KNXeasy Monitor is a tool to write values on EIB group addresses or read the current value of an
EIB group adress. The commands get converted to the KNXeasy protocol and then they get sent to
the KNXeasy gateway. The gateway sends the commands to the eibPort.

The KNXeasy Monitor sends the data in the format below:

Protokoll SystemID Command Adress Value

So if you want to send the EIS_1 value "1" on the group adress 1/0/1 at the eibPort with SystemID 0,
the command reads as follows:

KNXnet/IP 0 write 1/0/1 EIS_1 on

You don't have to write these commands yourself. The manager generates the commands by using
the array "Generate Command".
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Beispiel: Senden eines Kommandos

@Manager - b.a.b-technologie gmbh B [m]

File Configuration ‘Window Extensions Help
| =
1 | [ Project Exploration

T KMxeasy Monitor 53 I

=l Configure Connection

Current Target: 1172.31.49.127

Target Host: |172.31 40,127 P—
Part: I 4950 ::I disconmect. ..,

KurT Monitor

o || & o]

Received: | 11:55:53,466: Connecting. . =]
11:55:53,515: Connected UDP Socket on port 4950

Command: | KMxnet/IP 0 write 1/0/1 EIS_1 on J—

=] Generate Command

Protocal: IKNXnetII'IP j address: |1."'3."1 I
SystemID: |0 = Ers-Type: [E15 1 |
Command: Iwrite j Yalue: IDn

KurT Carmmand: |KNXnetIIP 0 write 1/0/1 EIS_1 on

|

figure 26 Views KNXeasy-monitor

First you have to connect to a KNXeasy gateway. Enter the IP of the gateway in the array "Target

Host" and click "Set Target".
Complete the checkboxes to generate the command. Here we send "1" on the group adress 1/0/1 at

the eibPort with SystemID "0".
Click "send" after completing the checkboxes. The command gets sent to the gateway and you can

see it on the monitor.
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F: How do | discover KNXeasy if | have lost the IP address?

A: Open the discovery window in your manager. Klick on the Window menu and schoose Show View >
Other > Device Overview. You can only discover KNXeasy devices which are in the same network
than your client PC or every router between your PC and KNXeasy is configured to forward
Multicast messages for the group 239.192.168.27 on port 1735.

F: 1 don‘t see any KNXeasy data in the KNXeasy monitor.

A: Verify the KNXeasy configuration for broadcast address and broadcast port. If the broadcast address is
not in the configured subnet, you have to enter a valid gateway. The gateway can be KNXeasy
itself. if you dont have a network router.

F: Why are KNXeasy messages not translated into KNXnet/IP or not sent on EIB?

A: Verify if your entered broadcast address covers the KNXeasy, too. Check the filter rules in your
KNXnet/IP gateways. The groupaddresses and physical address configured for KNXeasy must not be
blocked.
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